
ADScan  
User‘s manual



2

1. Background information

Table of content
1. Background information  ..........................................3

1. 1 Introduction  ................................................................3
1. 2 Scope of delivery ........................................................3
1. 3 General instructions for use .......................................4
1. 4 View on device ...........................................................4
1. 5 Safety instructions ......................................................5

2. Preparations .............................................................7
2. 1 Requirements for application environment  ................7
2. 2 Setting up the ADScan ...............................................8
2. 3 Starting the ADScan ...................................................9

3. Operating the ADScan via user menu ..................... 9
3. 1 Menu: Test ................................................................10
3. 2 Menu: Test selection.................................................11
3. 3  Client menu ..............................................................12
3. 4 Options .....................................................................17
3. 5 Test execution ..........................................................21

4. Operating the ADScan via ADScanalyzer ..............23
4. 1 Installing the ADScanalyzer ......................................23
4. 2 How to create a client ...............................................24
4. 3. Selecting a client and 
 Changing client data .................................................26
4. 4 Conducting a test via remote control function ..........27

5. Results....................................................................30
5. 1 Transmitting the results ............................................30
5. 2 Reviewing results  ....................................................31
5. 3 Reviewing and analyzing the results ........................32
5. 4 Deleting data from the ADScan ................................35
5. 5 Data import and export .............................................35

6. Maintenance and technique ...................................36
6. 1 Fault location ............................................................36
6. 2 Maintenance and Calibration ....................................38
6. 3 Cleaning ...................................................................38
6. 4 Storage .....................................................................38
6. 5 Disposal ....................................................................38
6. 6 Technical data and PC-System requirements ..........39
6. 7 Type plate .................................................................40
6. 8 Information about electromagnetic compatibility ......41

7. Service....................................................................45
7. 1 Contact data .............................................................45
7. 2/3 Warranty and details regarding EC conformity .........45

Table of content



3

1. Background information

1. Background information 
In this fi rst Chapter you will fi nd general information about the 
ADScan unit.

1. 1 Introduction  
The ADScan unit allows you to measure the level of attention as 
well as the intensity of movement in children age 4 to 12. All ga-
thered data can be stored correspondingly per client.  The result 
analysis is conducted with the help of the ADScanalyzer software. 
Transmitting recorded data is done via a USB interface. 

1. 2 Scope of delivery
The ccope of delivery of the ADScan unit (2520-SET-GB) includes 

Product Ident-Nr.
(for follow up 
orders)

• ADScan  unit including power adapter 
(type FW7556M/12)

2520

• USB-Isolator 
Connecting the ADScan unit to the computer

2548

• USB-Connection cable 
USB-A to USB-Mini-B (data transmission)

8748

• USB-Connection cable 
USB-A to USB-B (data transmission)

9897

• Push button for the CPT test
Wooden ball on a cable (length 2.90 m) 

9109

• Measuring tape 
length of 3 m – to measure the suitable 
distance between client and unit.

9120

• Tripod holding plate 
Connecting the ADScan unit to a tripod

7993

• ADScanalyzer* software on CD-ROM 2521
• Manual including CD-ROM 5021

All components are provided in a hard-top case (Prod.-Nr. 9121). 
It is recommended to use this case for longer storing periods and 
for transportation of the unit. 
The scope of delivery includes a tripod (Art.-Nr. 7992), which is 
transported separately.

Attention! Use only the provided accessory or - in case of 
damage or loss - the spare parts listed above. 
Other articles may cause more powerful emissi-
on or reduce the immunity of the ADScan unit.

*  The lastest software version as well as software patches can be found 
at www.download.meditech.de. Please note that only clients with a 
valid service contracdt are eligble to receiving such updates. 

Introduction
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View on device

1. 4 View on device
Operating the ADScan unit intentionally is limited to very few steps 
you need to take. Hence the number of buttons, switches and so-
ckets is quite moderate. Nevertheless you are asked to take the 
time to get acquainted with all elements of the ADScan unit. 
On the front panel you can fi nd the following elements:  

Display

Left step Right step Return key

User buttons

Symbol Display

The rear side contains the following elements:  

Socket to 
connect the 
push button

Connection for 
power adapter

On/Off switch
USB connection
  to USB isolator

1. 3 General usage instructions
You can enter a client directly on the ADScan unit or via remote 
control using the ADScanalyzer software. The analysis of gathered 
data is done solemnly in the ADScanalyzer software. You may select 
which ever process suits you better.
In the fi rst part of this manual it is explained how to operate the unit, 
after that the. remote control function is described.  

  
General notes
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1. 5  Safety instructions
The ADScan is designed to assess the level of alertness and 
corresponding controlled reactions towards specifi c stimuli as well 
as movement and movement intensity over an extended period of 
time. This process is intended to help professionals to determine 
the probability of a client being impacted by ADD/ADHD (attention 
defi cit disorder with/without hyper activity). The device allows for 
a screening analysis and in particular to train and adjust the level 
of movement and alertness in the client.  
Any usage directed to a different objective is prohibited. As long 
as the installation is done properly, all instructions and warning 
notices are followed, the health and safety of the user and third 
parties are fully safe. Correspondingly, this active medical device 
can be put into circulation and operated for short-term usage in 
accordance with medical law standards.

Safety instructions

 

Attention! Do not use the ADScan unit in rooms containing 
infl amable mixtures, such as mixtures of anes-
thetic mixtures or oxigen or laughing gas. Such 
mixtures may be ignited.

Attention! During the test, movement is measured using 
double radar waves.

Attention! Use only the provided accessory or – in case of 
damage or loss – the spare parts listed above. 
Other articles may cause more powerful emission 
or reduce the immunity of ADScan.

Attention! Protect the unit from ultrasound baths, severe hu-
midity as well as chemical detergents. The device 
could be destroyed.

Attention! Do not open the unit on your own! Do not attempt 
to self-repair the unit. The device could be severely 
damaged. Important: By opening the unit all and 
any warranty claims are nil and void.

Attention! Protect the ADScan unit from severe blows. The 
device could be damaged. 

Attention! Store and transport the ADScan unit only in the 
special hard-top case in which the unit was provi-
ded to you.  
Doing so, the unit is suitably protected from 
shocks during transport or storage.
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Safety instructions

Attention! Clean the ADScan prior to fi rst usage. Strictly 
follow the instructions provided to you in the 
chapter dealing with “Cleaning”.

Attention! The ADScan must not be arranged stacked di-
rectly next to or with other devices. Just in case 
that a stacked arrangement of the operation is 
required, the ADScan should be monitored to 
verify its proper operation in the used confi gu-
ration.

Attention! The ADScan may be disturbed by other devices, 
even if they match the external connection re-
quirements valid for CISPR.

Attention! For medical reasons the color RED is needed in 
the LEDs in the ADScan unit, even though DIN 
EN 60601-1 paragraph 7.9 solemnly limits this 
color to danger or the projection of an immedi-
ately needed action. There are no dangerous 
situations in the use of the ADScan that would 
require a corresponding warning signal.  

Attention! Note that you use the ADScan unit only with 
the frequency range permitted and specifi ed 
for your respective country.

Attention! The manufacturer is not liable for damage due to 
improper usage of the device or due to neglect 
of the safety instructions. 

Hint The ADScan is a medical electrical de-
vice and, hence, subject to special precau-
tions concerning electromagnetic compatibili-
ty. The device may be put into operation only 
according to the notes given in this manual 
(page 41 +)
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Test preparations

2 Test preparations
In this Chapter you learn how to prepare working with the ADScan 
unit. This includes: Selecting an adquate test environment, setting 
up the unit, starting the device, client entry and test selection as 
well ashow to handle the functionality of the built-in menu structure.

2.1  Requirements for the application environment  
• Quiet. Ensure to avoid:  telephones, loudly ticking clocks or 

similar sources of potential noise and disturbances that could 
reduce the clients level of concentration. 

• Relatively dark / with the option of closing out external lights
• Comfortable temperature without draft at approximately 20 °C. 

To high or low temperatures may impact the measurements. 
• Room must be at least 4 m long.
• 230V power socket immediately next to the unit’s placement
• Comfortable seat for the client
• Table and chair for the tester.

Important: Ensure that your seat is not within a 90° radius in front 
of the ADScan unit. The same holds true for all and any movable 
parts ( (i.e. plant leafs or curtains). Otherwise such movement 
could be likewise measured and impact the overall measurement 

Attention! Ensure that the cables connecting the 
ADScan with the power supply or the com-
puter create no tripping hazards. Place the 
tripod in such a way that you or others cannot 
trip over the tripods legs to avoid the danger 
of injury or damage to the unit.
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Setting

2.2  Setting up the ADScans
1. Connect the holding plate of the ADScan to the upper end of 

the tripod. In order to do so, positon the holding plate on the 
screw thread and turn it clockwise until it is securely positioned 
on the tripod without reeling. 

2. Preferably position the tripod closely to a wall. Spread the 
tripod’s legs to ensure a greater level of stability. 

3. Adjust hight and gradient of the unit by losening the tripod 
thread, adjusting the respective positions and re-tightening 
the tripod thread.  

Hint:  If you wish to control the ADScan device with the 
ADScana¬lyzer software or transmit data, 
connect the unit to the computer as described 
in the following: 
• Connect your USB-Mini-B-jack of the 

connection cable into the corresponding socket of the 
ADScan device.

• Insert the USB-A-jack (on the other end of this cable) 
into the respective USB-isolator socket.

• Connect the USB-B-jack of the other connection cable 
with the remaining free socket of the  USB-Isolator.

• Insert the USB-A-jack (on the other end of the second 
cable) into one of the USB-plugs of your computer. 

4. Connect the small jack of the power adapter into 
the corresponding socket on the ADScan unit. 

5. Place the actual power adapter into the power 
socket outlet.

6. Position the client’s seat three meters directly in front of the 
ADScan unit. 
Take notice of the following further recommendations: 
• Your client should not be blinded by sunlight or lights in your 

room. If needed make sure to cover / blend out the correspon-
ding light source. 

• No light should refl ect either from the display or the LED dot 
matrix. Ensure to avoid direct light emittance onto the unit. 

• The client must be able to easily see the LED dot matrix dis-
playing the various symbols withouth having to 
turn the head at all.  
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2.3 Starting the ADScan
1. Turn the on/off key to the left  . 

In the display you will see a short sequence of informa-
tion. Please do not press any buttons during this start-up phase 
(for about 10 seconds).  

3.  Operating the ADScan unit with the built-in 
menu structure

In this Chapter you learn how to use the different menus offered 
by the ADScan unit. 
General display information: 
After turning on the device you are in the main menu. Menu entries 
are explained hereafter

General information on the menu structure: 
The ADScan  unit is menu-based. The menu has different levels 
and the following structure:

Main menu 1
Test: norm test

****************
* ADScan *

15.02.2011 13.28
HELLO

****************
Client: Mueller

Main menu 1
Test: norm test

Firmware version
x.xxx

Entry screen

Current Firmware Version –  
You may be requested to provide this 
information when seeking support. 

Date and time

Currently selected client. 
Change selection as needed.
Main menu   
(fi nal screen after initialization)

Name of menu

Available option / 
submenu title 

Menu identifi er

1 Test 2 Select test 3 Client menu 4 Options
1-1 Start test 2-1 Norm test 3-1 Client: 4-1 Date
1-2 demo test 2-2 Norm test long 3-2 Select client 4-2 Summer time
1-3 demo test (long) 2-3 REST-Scan 3-3 Change client 4-3 Time
1-4 << back 2-4 REST-Scan (long) 3-4 Create Client 4-4 LED-Dot-Matrix

2-5 CPT-V 3-5 Delete client 4-5 unit temperature
2-6 CPT-V long 3-6 Delete all 4-6 Memory capacity
2-7 << back 3-7 << back 4-7 Menu language

4-8 Quickselect keys
4-9 Firmware version
4-0 << back

Start device

Operating with 
menu structure

If you prefer to use 
the remote control 
functionality for the 
ADScan unit, please 
continue with 
chapter 4
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Test menu

How to move within the menu:
• Press   respectively , to switch options within the menu 

and to select the desired submenu.
• Press , in order to switch to the marked submenu. 

If  << back is highlighted you can switch to the next menu 
level above by pressing 

yy
. 

How to handle each option is based on the menu sequence.

1 Test
2 Select test
3 Client menu
4 Options

3.1  Test menu
From within the main menu you launched the submenu test. In 
this menu the following options are available:

Name Meaning
1-1 Start test Startet the test which was chosen in the sub-

menu Select test
1-2  Demo-Test 10 sec.  demo of the  CPT-V-

test sequence  (fi gure in the symbol display) 
1-3 Demo-Test long 15 sec.  Demo of the  CPT-V-

test sequence  (fi gure in the symbol display) 
1-4 << back back to main menu

1. Press   respectively  until the option you wish to choose 
is highlighted. 

2. Press , to confi rm your preselection and to launch the 
selected menu option. 

Advice: 
• Tests start immediately after a 4-second Countdown indica-

ted by fi ve beeps. 
• You may abort tests by pressing   No recorded data will 

be stored when aborting. 
• You cannot abort test demos.
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Test selection

3.2  Test selection
You have launched the submenu test selection from within the 
main menu. Here you can choose from the available test options 
which test you wish to conduct with the current client:

Name Meaning
2-1   Norm test • Procedure: Client presses push-button 

whenever the symbol sequence  -> 
appears. After completion of this step, move-
ment is measured again during the rest scan. 

• Duration: approx. 20 min. (10 min + 10 min.)
• Consists of CPT-V + rest scan

2-2 Norm test long • Procedure: Client presses push-button, 
when ever the symbol sequence  ->  
appears. After completion of this step, move-
ment is measured again during the rest scan. 

• Duration: approx. 26 min. (13 min. + 13. min.)
• Consists of CPT-V lang + rest scan long

2-3 REST-Scan • Procedure: Movement / movement intensity 
are measured during a rest phase (during 
which the client is asked to sit still).

• Duration: approx. 10 min.
2-4 REST-Scan 

long
• Procedure: Movement / movement intensity 

are measured during a rest phase (during 
which the client is asked to sit still). 

• Duration: approx. 13 min.
2-5  CPT-V • Procedure: Client presses push-button, 

whenever the symbol sequence  ->  
appears. 

• Duration: approx. 10 min
2-6 CPT-V lang • Procedure: Client presses push-button, 

whenever the symbol sequence  ->  
appears.   

• Duration: approx. 13 min.
2-7 << back Back to main menu

1. Press  respectively  until the test is pre-selected which 
you wish to conduct. 

2. Press  twice to confi rm your selection and then launch the 
test in the test menu.  

Advice: 
• Tests start immediately after a 4-second Countdown indica-

ted by fi ve beeps.  
• You may abort tests by pressing  abbrechen. No recorded 

data will be stored when aborting. You cannot abort test 
demos.

CPT = 
Continuous 
Performance 
Test (repetitive 
task combined 
with scanning 
the movement 
index)
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3.3  Client menu
You launched the client menu from the main menu. Here you can 
administrate all data concerning your client. You can choose from 
the following options: 

Name Meaning
3-1 Client: Shows the currently selected client (surna-

me, fi rst name)
3-2 Select client Select the client from the pre-stored client 

list for which you wish to conduct a test.
3-3 Change client Edit saved client data.
3-4 Create client Enter new client.
3-5 Delete client Delete an existing client. 

Careful: You will erase all personal and test 
data connected to this set of data!

3-6 Delete all Delete all client data. 
Careful: You will erase all personal and test 
data connected to this set of data!

3-7 << back Back to main menu

1. Press   respectively  until you highlighted the option which 
you wish to start.  

2. Press , to confi rm your selection and to launch the desired 
option. 

3.3.1 Menu Client 
From within the client menu you chose the option client:. In the 
display you see:
The name behind client:, fully visible in 
the ticker display shows the currently 
active client.
This is information on display which you cannot change here. In or-
der to select a different client, switch to Select client or New client. 
 
1. Press , to close the display of the client name. You are back 

in the client menu. 

Cli  ent menu 3-1
Client: Testinge

Client menu
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3.3.2 Menu  Select client
From within the client menu you chose 
Select client. The Display reads:

You wish to select this client? 
1. Press  to return to the client menu.

You wish to select a different client? 
Here all clients are listed including their device ID in the sequence 
of how they were entered into the device. 
1. Select the desired client: Press  respectively , to fi nd the 

client in question. 
2. Press . The display shows the currently selected client. 

You cannot fi nd the desired client?

Maybe the client was not yet created or was delete. 
1. Press  respectively , until you get to << End search. 
2. Press . This will end the search and you return to the client 

menu. Now you can add the desired client in the New client 
menu. 

3.3.3 Menu Edit  Client
From within the Client menu you chose Edit client. Here you can 
client settings, i.e. if the client’s name changes or there was a 
mistake in the original entry. 
The display shows:

Changing the surname 
1. Press  until you reach the letter you wish to change. The 

small black line underneath the letter indicates which letter is 
currently highlighted.

2. Press   respectively , until you entered the letter you 
seeked. 

3. Press , if you want to change further letters and report top 2. 
Overview on functions and key combinations

Surname:
Xxxx

Select client
001:Xxxxx, Xxxx

Client menu



14

3. Operating the ADScan via user menu

Press ... Leads to
Jump to next letter or
insert a new letter at the end.

 Replace the currently highlighted letter with 
the previous one in the alphabet (t turns into s).
Replace the currently highlighted letter with the 
next one in the alphabet (s turns into t).

 +  
(at the same time)

Delete the highlighted letter. 
All further letters move forward by one. 

 +  
(at the same time)

Jump one step to the left. 
The letters remain unchanged. 

 5 seconds! End and confi rmation of entry.

Tipp:  If you press   respectively  for a longer period of time, 
you can scroll through the letters of the alphabet faster. 

1. When you are done with your entry: Press  for about 5 se-
conds until you read First name in the display. 

Changing the First name 
1. Press  until you see First name in the display.
2. Change the desired letters as described in Changing the 

surname. 
3. Then press  for about 5 seconds, until you see Date of birth 

in the display. 

Changing Date of birth and/or Gender
1. Press   as needed for 5 seconds, until Date of birth shows 

on the display.  
2.  Press   respectively , until the right day shows. The small 

black line underneath the numbers shows that you can enter 
the date. 

3. Press , to be change the month. 
4. Use   respectively  to change the month and then press  

 to set the year. 
5. Change the year as needed pressing  respectively  then 

press  , to confi rm the settings made. The display shows 
Gender.    

6. Press  for male respectively  for female. 
7. Press , to confi rm the gender settings. 
8. Press  for yes, to confi rm the changes made respectively  

 for no to revoke the changes. 

Client menu
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3.3.4 Menu New Client
From within the Client menu you chose New client. In this menu 
you can create a new client – fully independent from the computer. 
If the respective client is selected, the session recordings will be 
allocated to this client. 

Surname ...
1. Press   respectively , until you entered the desired letter. 
2. Press . To insert another letter. 

The little black line underneath the letter indicates, which letter 
is currently selected. 

3. Repeat steps 1 and 2 until inserting the client’s surname is 
completed. 

Overview on functions and key combinations
Press ... Leads to

Jump to the next letter or 
insert a new letter at the end

 Replace the currently highlighted letter with the 
previous one in the alphabet (t turns into s).
Replace the currently highlighted letter with the 
next one in the alphabet (s turns into t).

 +  
(at the same time)

Delete the highlighted letter. 
All further letters move forward by one. 

 +  
(at the same time)

Jump one step to the left. 
The letters remain unchanged. 

 5 Seconds! End and confi rmation of entry.

Hint:  If you press the keys for a longer period of time, you can 
scroll through the letters of the alphabet faster. 

4. Press  for about fi ve seconds until you read First name in 
the display. Hereby you confi rm the surname entered. 

First name ... 
5. Press   respectively , until you entered the desired letter. 
6. Press . Doing so you insert a new letter.
7. Repeat steps 5 and 6 until you fully entered the client’s fi rst 

name.
8. Press  for about 5 seconds until the display reads date of 

birth.

Client menu
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Date of birth ... 
9.  Press  respectively , until you entered the day. 
10. Press . The small black line now highlights the month digits. 
11. Repeat steps 10 and 11 for month and year 
12. Press . The display now reads Gender.

Gender  ... 
13.  Enter the client‘s gender: 

• Press , for a male client. 
• Press , for a  female client. 

14. Press . After a few seconds the complete set of data is being 
displayed in full.

Save data ... 
15. Decide if you wish to save or to discard the changes: 

• Press  for yes in order to save the changes.
• Press  for no in order to discard the changes. 

 This will lead you back to the Client menu. 

3.3.5 Menu Delete client
From within the Client menu you select Delete client. Here you 
can delete client data including corresponding test results. Use 
this command with caution. 
Here all previously entered clients are listed with their IDs in the 
sequence of how they were entered.  
1. Select the desired client: Press dazu  respectively , to 

highlight the corresponding client. 
2. Press . You see a security query:

• Press  for yes in order to permanently delete the data.
• Press  for no in order to keep the data. 

 This will take you back to the Client menu.

3.3.6 Menu Delete all
From within the Client menu you choose the Delete all option. Here 
you can delete all client data and the corresponding test records. 
Use this menu with caution. 
1. Press . You see a security query:

• Press  for yes in order to permanently delete the data.
• Press  for no in order to keep the data. 
This will take you back to the Client menu.

Client menu
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3.4 Options
From within the Main menu you opened the Options menu. Here 
you can adjust general settings. You may choose from the follo-
wing options: 

Name Meaning
4-1 Date Setting/adjusting the system data – usually 

not necessary.
4-2 Summer time Shows if summer time or winter time is se-

lected
4-3 Time Display and settings / adjustment of the time 

– usually not necessary. Required when 
travelling into different time zones or when 
switching between summer and winter time.

4-4 LED-Dot-Matrix Contrast of the symbol display (LED dot ma-
trix). Depending on the room’s brightness 
and the client’s light sensitivity the contrast 
may be adjusted. The LED lights must be 
easily visible for the client.

4-5 Unit 
temperature

Displays the current device temperature. 
Ensure that the device has an operating 
temperature of 15°C to 30°C  (ideal: 20 °C), 
in order to ensure comparability of all recor-
dings.

4-6 Memory Capacity Shows how much free memory is still availa-
ble. Recommendation: Upon a percentage 
lower than 25 % ensure to  free a signifi -
cant amount of memory space - see chapter 
3.3.5 or 5.5. 

4-7 Menu language Here you can change the menu language. 
4-8 Quickselect keys Here you can change the key‘s sensitivity.  
4-9 Firmware version Shows the current fi rmware version active in 

the device – You may be asked to provide 
this information when seeking our technical 
customer support.  

4-0 << back back to main menu

1. Press    respectively  until you highlighted the option 
which you wish to start.  

2. Press , to confi rm your selection and to launch the desired 
option. 

Options
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3.4.1 Submenu time / submenu date

These two menus are operated iden-
tically so that they will be explained in 
parallel.

From within the Options menu you 
selected the Time / Date option. The 
display reads:

Show Time / Date 
1. Press .  This is for information only – you settings available.
2. Press  again. You return to the Time / Date menu.

Change Time / Date 
Display and settings / adjustment of the time – usually not neces-
sary. Required when travelling into different time zones or when 
switching between summer and winter time. Usually there is no 
need to change the date once it was set correctly!

1. Press . The display shows Set 
Time / Set Date. 

2.  Press . In the upper half of the 
display you read Set Time / Set Date. In the lower half you 
see the current time / the current date. The small black line 
underneath the number indicates that you are in the process 
of changing it.  

3. Press  respectively , until the correct hour / the correct 
date is showing.

4. Press , to switch to minutes / months The small black line 
moves on along. 

5. Press   respectively , until the correct minute / the correct 
month is showing. 

 For date: 
• Press , to switch to year.
• Press   respectively , until the correct year is showing. 

6. Press , to confi rm the new time / the new date. You return 
tot he Time / Date menu.

You wish to exit the Time menu?
1. Press , until you see << back in the display.  
2.  Press . You now are in the menu Options. 

Show time

Change time
12:10:00

Show date

Change date
28.02.2011 Mo

Options
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3.4.2 Menu  LED-Dot-Matrix

In the Options menu you have selected the LED-Dot-Matrix. The 
display reads:

In addition, the symbol matrix shows a red cross: 

In this Menu you can adjust the contrast for the LED-Dot-Matrix de-
pending on the brightness / darkness of the room and your client’s 
eyesight. It is mandatory that your client sees the symbols well.

1. Adjust the contrast depending on the given settings and re-
quirements: 
• To reduce the contrast press .  

The value on display goes down. 
• To increase the contrast press .  

The value on display goes up. 
2. Once the contrast is adequate press . This confi rms and 

saves your settings. You are back in the menu Options.

3.4.3 Menu Device temperature
From within the Options menu you chose the Device temperature 
option. The display shows the current device temperature.
This is information which you cannot 
modify.
The temperature depends on the current room temperature as 
well as the operating time of the device. 
Ensure that the device temperature levels between 15 °C and 
30 °C, to allow for a full comparability of the test results with the 
existing normative database.
1. Press . This closes the temperature display. You return to 

the menu Options.

3.4.4 Menu Data storage 
From within the Options menu you select the Data storage option. 
The display shows the currently available memory capacity in %.
This is merely for information, the num-
ber cannot be changed here. 
The value on display should not be below 25 %. If too low, free 
additional memory by deleting client data AFTER transmitting them 
to the ADScanalyzer software. 
1. Press . You close the current menu option and return to the 

menu Options.

LED-Dot-Matrix
- 0 +

Unit temperature
+ 20,8 Celsius

Options 4-5
Free: 95%

Options
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3.4.5 Firmware-Version menu
From within the Options menu you select the Firmware version 
option. The display shows the currently 
installed fi rmware version number
This display automatically returns to the menu options after a few 
seconds. 

Option << back
In the menu options menu Options you now see the << back 
option. 
1. Press . This closes the Options menu and you return to the 

Main menuu. 

Firmware version
X.xx

Options
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3.5 Execution
In this chapter you learn how to conduct tests with the ADScan after  

• selecting the requested test.
• selecting or creating the corresponding client.
• preparing the test environment. 

3.5.1 Test instruction  

Below you fi nd recommendations as to how to instruct your client.
1. Please take a seat on this chair and make yourself comfortable.
2. The test will take quite a bit of time.
3. (only when referring to normtest and CPT) 

• Please hold this push button. (pass the push button on to 
your client) 

• In a moment you will see a sequence of symbols here (point 
to the LED matrix on the ADScan unit. Those symbols will 
appear at random, i.e. in no perceivable order). 

• Only press the push button, when you see a square and then 
right afterwards a plus sign. 

• ONLY when these to symbols appear in this order right 
after one another, you press the push button as fast as you 
possibly can.

• If you only see one of those two symbols, do NOT press the 
push button.

• This device registers your entries and counts your score. If 
you press the button when the two symbols were not in the 
right sequence or if you miss pressing the button when the 
correct sequence appeared, the ADScan unit will notice and 
record this also. I will tell you your result later. Once the fi rst 
test is complete you will hear a beeping sound.  

4. At that point, I will press this button, and you get to relax and 
are asked to sit as still as possible. You no longer need to 
monitor the signals from there on. 

5. Do you have any questions about the test? (answer all ques-
tions suitable for your client’s age). Now we shall proceed.

6. Let’s do a demo round fi rst to make sure everything is clear 
and working)

Important: Do not notify your client about the fact that his move-
ment / movement index is being monitored by the device. 
Else this could have a falsifying effect on the data and 
corresponding evaluation!) The neutral suggestion to sit 
as still as possible should be very suitable.

 then  

Execution
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3.5.2 Test execution

After making sure in the demo round that your client has fully 
understood what to do, you now launch 
the actual test sequence.  

1. Press . This will take you to the 
menu option Test.

2. Press erneut . once more. This will 
launch a test.

The ADScan unit will now launch the test. After a sequence of four 
short and one long beeps the actual recording starts. 

If you chose norm test or CPT-V in the LED dot matrix the dif-
ferent symbol are briefl y on display. 
The Client must notice the   and then  symbol and then press 
the push button. The ADScan device registers correct and incorrect 
responses as well as missed sequences. In addition the unit records 
movement and motion intensity. 

Important: In order to prevent the test from being distorted, ensure to 
stay clear of the ADScan unit and well outside a 90° angle in front of 
the device. Otherwise your movement will also be recorded, impacting 
the overall data and tainting the test results. 

The fi rst part of the test (CPT-V) takes 10 min. If you chose the long 
option it will take 13 min.  

Once done the unit will beep for one second to indicate the end of the 
recording. The display reads:  

If you chose Norm test press , in order to continue with a Rest scan. 
The Rest scan yet again starts after another 4 seconds countdown (a 
total of fi ve beeping sounds).

If you chose Rest scan the recording will take 
10 min. If you chose Rest scan long the recording of motion intensity 
will take a total of 13 min. 

End of test – independent from the type of test you chose – 
The test ends with a one-second beep. The display shows the Main 
menu and indicates that another recording can be initiated. 

Main menu 1
test: norm test

Test 1-1
Start test

Normtest
is running

Normtest
Go on with start

Execution
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4    Operating the ADScan via ADScanalyzer
In this Chapter you learn, how to operate the ADScanalyzer soft-
ware and how to control the ADScan unit via computer.
If you connect the ADScan unit to a PC prior to starting a test 
(see Chapter Connecting the ADScan unit to the computer) the 
software recognizes the device and deactivates the integrated unit 
menu and awaites commands from the ADScanalyzer software. 
The analysis itself always is done via ADScanalyzer software, no 
matter if the unit was self controlled or run via the software. 

4.1   Installing the ADScanalyzer software
Do not connect the ADScan unit to the computer or leave it turned 
off. A setup assistent guides you through the software installation 
routine of the ADScanalyzer software. It is quite like other installati-
on routines that you are familiar with from other software solutions. 
1. Insert the ADScanalyzer CD in the corresponding CD/DVD 

drive on your computer. 
2. Select the desired installation language and press OK. 

• If the setup assistant does not autostart, select Start 
--> Run…. Click on Search. The search window now 
opens.

• Select the path of your CD/DVD drive. 
• Click on the Setup.exe fi le and then click OK.  

3. The setup assistent starts. Click on continue and follow 
the stps offered by the setup assistant.

4. After a few steps you see the window Select target 
folder. Choose the folder in which you wish to store the 
program and the corresponding recordings. 

Recommendation: Wählen Sie für die Installation den 
vom Programm vorgeschlagenen Pfad. Das erleichtert im 
Falle eines telefonischen Supports die Suche nach gespeicherten 
Daten. 
5. Select the installation path suggested by the program. 

This will make all and any technical support easier when 
searching for existing recordings. 

Install 
ADScanalyzer
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4.2    How to create a Client
In this Chapter you learn how to create a new Client in the da-
tabase. 
1. In the Files menu click on New Client. The Client data window 

opens up. 

2. Click into the entry fi eld behind Surname. Enter the client’s 
surname via keyboard.

3. Press the tab key on your keyboard or clickinto the the entry 
fi eld behind First name after completely entering the surna-
me. You will now see the cursor blinking in the First name 
entry fi eld. 

4. Enter the client’s fi rst name. After completing the entry, con-
tinue in the same way with the Date of birth.  

5. Enter the client’s  date of birth. Please note the entry format 
MM/DD/YYYY (i.e. 02/15/2004 for Feb. 15th, 2004). Then 
continue with Gender. 

6. Enter m for male or f for female for the corresponding client 
gender, then switch to +.  

7. Enter the client’s weight in kilogram (kg). This enables you to 
compare clients of similar age, weight and gender. 

How to create a 
Client
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8. In the entry fi eld Background information you can record 
comments, recommendations and likewise information. 

9. Click into the label fi eld and enter the Client number / Iden-
tifi cation number you have assigned to your client in your 
client software. 

10. If your client is taking prescribed medication that could impact 
the test you can document that under Medication. 

11. Click on the Questionaire button. The standard questionnaire 
which was also used during the tryout and data acquisition 
phase of the ADScan unit, pops up.

12. Fill out the questions one after the other by selecting Never/
rarely, occasionally, often or very often depending on your 
client’s feedback. Click OK once thequestionaire is fi lled out 
completely. Should you have missed any questions, the pro-
gram will alert you correspondingly.

13. Click OK once all data has been entered. This completes 
entering a new client.

14. This client is now active, so that you can conduct a test with 
him. The program displays the active client in the main window 
(Menu View option Results or Remote control.

Entering additional Client documentation
You can add a more extensive client documentation on 
psychological constitution as well as documentation based 
on ICD-10 (Revision 10). (ICD = International Catalogue of 
Deseases, an international statistic classifi cation of deseases 
and related health issues – further information on ICD-10 can 
i.e. be found on the internet at the following link: http://www.
dimdi.de/static/de/klassi/icd-10-gm/kodesuche/onlinefas-
sungen/htmlgm2013/index.htm 

How to create a 
Client
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4.3  Selecting a client and changing client data  
After successfully entering all client data you can change the 
entries at any time. Current client situation, medication etc. can 
be adjusted as needed. Simply fi rst select the client whose data 
you wish to modify. 
If the client is not yet selected, go to the Files menu and select 
the Open database option, then double-click on the desired client. 
1. Now select Client data sheet from the Files menu. The client 

data sheet, which you already know from the Create New 
Client menu, now pops up. 

2. Conduct all required modifi cations, then close the window 
by clicking OK. 

How to select / 
change a Client
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4.4  Conducting a test via Remote control
Step 1: Select client
Step 2: Technical preparations
Step 3: Client preparations
Step 4: Main  CPT
Step 5: Rest Scan

Step 1: Select client
 Choose the client you wish to test. To do so, read Chapter 

Selecting a client.

Step 2: Technical preparations
 In order to run a test via ADScanalyzer remote control it is 

necessary to connect the ADScan unit to the computer on 
which the ADScanalyzer software is installed. How to connect 
the corresponding components you learn in chapter Setting 
up the ADScans. 

 In addition the ADScan unit must be turned on. 

Step 3:  Client preparations – Explanation and Demo
1. Click onto New test in the Files menu. Alternatively you 

may also select Remote control in the View menu.  
The following window appears 

2. Click onto Start demo. On the screen you see instruc-
tions on how to set up and conduct the test.

3. Check if your setup meets the described requirements. 
The normative data was obtained based on those exact 
settings.

4. Click on Continue > when the settings are adequate. The 
explanation for the CPT appears. Instruct your client in a 
way suitable for your client’s age. Instructions are being 
displayed on the screen. 

5. Once the client has understood the instructions for the CPT, 
click on Continue >. The instruction card for the Rest Scan 
appears. Instruct your client in a way suitable for his age. 
Suggestions are included in the instruction card.

Conducting a test
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6. Once the client has understood the instructions for the CPT, 
click on Continue >. The instruction sheet on Save data 
appears

7. Once the instruction are fully clear to you click OK. The Demo-
CPT starts directly and takes up to 30 seconds: The demo 
starts with a countdown which consists of four short and one 
long beeping sound. 
The CPT symbols appear in the LED dot matrix above the 
ADScan display. 
Monitor your client’s actions. If they are in line with the given 
task, you can launch the main CPT. If the client obviously did 
not fully grasp the task, repeat the Demo CPT up to three 
times and then launch the Main CPT.  

Step 4: Main CPT
The following window 
appears: 
Follow the instructions. How to contuct the test is thoroughly 
explained. 

• Once you checked the settings and your client’s understan-
ding of the test you can abort the instructions by clicking OK 
and start the Main CPT directly.  

The test starts with a countdown (four short and one long beeping 
sound). 
The client auto-determines the test duration depending on your 
client’s age: 

• Up to 10 years of age: 10:00 min.
• Older than 10 years: 13:20 min. 

The client is asked to sit relaxed and press the push button whe-
never the  symbol sequence (  then ).
You can assess the remaining time until the end of the test from 
the time that has passed already. 
Note:  Do not indicate to the client how much longer the test will 

take. 
Once the test has been completed a long beeping sounds indicates 
the end of the test.
Wait for about 2 minutes before starting the Rest scan. Your client 
may relax or i.e. drink something during this short brake. 

Conducting a test
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Step 5:  REST-Scan

Launch the Rest scan after 2 minutes. During this time the client 
shall sit still without being told that his level of movement intensity 
is being measured. 

Note: 
Please use the instructions provided to you with your ADScan 
system: „Now we conduct a second test. Please sit still for a 
duration of 10 min / 13:20 min. and move as little as possible. 
There will be a beeping sound once the test is complete.“ 

As before it is important that you do not indicate to you client how 
much test time remains.
You can assess the remaining time until the end of the test from 
the time that has passed. Once the test is complete a long beeping 
sound will occur and the Rest scan and the overall test phase for 
this client is completed. All recorded data will be saved.

 Premature test termination
You can abort the test if unforeseen events occur. 
Click on the suitable button 

ABORT with saving: The test / scan will be aborted, all recorded 
data will be saved.

ABORT without saving: The test / scan will be aborted, all trans-
mitted data will be rejected.. 

Conducting a test
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5. Results 
The results obtained with the ADScan unit (test and scans) can 
be transmitted to the ADScanalyzer software where they can be 
reviewed, analyzed, saved and deleted from the ADScan unit’s 
memory. 

5.1  Transmitting the results
No matter how you controlled the test – via ADScan unit or com-
puter software you can now review the data in the ADScanalyzer 
software. 
After completing the tests / scan, all data 
is still saved on the device. In order to 
review and analyze them, they must 
be transmitted onto the ADScanalzyer 
software:
1. Start the ADScanalyzer software.
2. Connect the ADScan unit to the 

computer. 
3. Start the ADScan unit and wait until 

the ADScanalyzer software recogni-
zes the device. 

4. In the View menu select the Remote control option. 
5. Click-select the data from the Scanner trial list which you wish 

to transfer to the ADScanalyzer software. The checkmark 
 in front of the corresponding set of data turns into .

Hint: If you already did conduct several tests, some of which you 
already transmitted, you can limit the recordings on display 
to the new recordings that have not yet been transmitted. To 
do so, activate the checkmark in front of Only show new data.  

6. Click on the button Receive selection once all sets of data you 
wish to transmit have been selected. The window Transmit 
test records pops up. 

7. Click Yes to start the transmission. 

Transmitting the 
results
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Note:  Depending on the amount of data stored the transmission 
may take some time. 

Hint:   We recommend transmitting your recorded data frequently 
to the ADScanalyzer software. This way you save the data 
on your computer and are able to delete data on the ADScan 
unit to create more room for further test records How to 
delete data is described in chapter Deleting test results. 

Once the data was transmitted from the ADScan unit onto the 
ADScanalyzer software they are saved in the program and ready 
for review and analysis. 

5.2   Reviewing results
After transmitting the results you can review the data of the active 
client in the ADScanalyzer software. 
1. Select Open database in the Files menu. On the left hand 

side you can see all clients registered in the ADScanalyzer 
database. 

2. Left-click on the client listed there whom 
you wish to review. This client now is 
highlighted in blue. On the right hand 
side you now see all the tests conducted 
with this client.

3. Left-click on the CPT scan and the Rest 
scan which you wish to review. They will 
then appear in the lower right hand corner of this window, 
indicating them being the selected tests. 

Note:  Once you select a test (i.e. a CPT scan) the ADScanalyzer 
software automatically adds the corresponding test (i.e. 
Rest scan). You can change the selection as needed. 
Under Free fi eld you may an add additional test run for 
comparison.

4. Click OK when all data is selected as intended. The result 
window pops up, and you  see the test analysis..

Reviewing results
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5.3   Reviewing and analyzing the results 

The graphical presentation of results is to be reviewed as follows: 
Presentation of the currently selected results:

As needed you can include / exclude specifi c elements. Simply 
select / deselect the corresponding checkbox.

Results of the selected CPT:

Element 1
Duration, date, test time and serial number of the ADScan unit 
used for the test 

Element 2Element 1

Element 4Element 3

Result review and 
analysis 



33

5. Results

Element 2
The blue line represents the movement inten-
sity throughout the duration of the CPT.

Element 3
The table fi le indicates how the client 
responded to the symbol sequence: 
Line by line the following information is 
provided: 
 Reaction (see below) -> Quantity (see below) ->  
reaction time in average -> Reaction time as standard deviation

Reaction and Quantity:
All = Occurance of the relevant symbol combination – here 51 x 
Correct = Number of correct keystrokes after the relevant symbol 
combination – here: 46 x (green indicator) 
Comission = Number of random or incorrect keystrokes – here: 
5 x (red indicator)
Omission = Missed keystrokes after the relevant symbol combi-
nation – here 4 x (orange indicator)

Element 4
The statistic data (see display element 3) are represented in their 
respective color in the graphic on the screen. The height of the 
colored lines indicates the corresponding response time.

Rest Scan results 

The illustration of the Rest Scan is very similar to the display 
elements 1 and 2 for the CPT.

Result review and 
analysis 
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Analysis and evaluation

The colored segments provide visual referential data for clients of 
the same age and gender. 
Segment interpretation (legend): 
• Green = no pathological fi ndings
• Yellow / Orange = with borderline values 
• Red =  potential pathological fi ndings
The vertical white bar represents the client’s score. Hence you 
can easily see how well he or she performed in comparison to 
the respective age group.
The ADScanalyzer software calculates the position of the white bar 
from the normative data, the CPT data, the Rest Scan as well as the 
questionaire, displaying the different scores and the overall result.
Examples: 

Result review and 
analysis 
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5.5  Deleting data on the ADScan unit
You may delete data stored on the ADScan unit with the help 
of the ADScanalyzer software. Deleting data from time to time 
is recommended to clear memory capacity on the device and 
speed up the system. Please take not of the potential risk of 
losing data by accident.  
Note: Save your data frequently. Transmit your recorded data 

from the ADScan unit into the ADScanalyzer database prior 
to deleting it from the device. Follow the instructions given 
in chapter Transmitting results.
1. Select Remote control in the View menu.
2. Highlight the data you wish to delete: 
3. Click on Delete selection: 

The window delete clients appears .
4. Answer the pop-up questions depending on your needs:

• Yes = Delete data. The client deletion process starts 
– you will receive a message once the process is com-
pleted. 

• No = No data is deleted, the process is aborted. 
Note: The button Delete all will erase all clients and recordings 

from the ADScan unit. Use this button with extreme caution. 

5.6  Data import and export
You can import data from other databases, respectively export 
and exchange it with other sotware ADScanalyzer databases. 
a) Import: 
Select Open fi le list / Import in the Files menu. 
• Highlight the data you wish to import and click on „import se-

lection into database”.

• Click on „Import all“ if you wish to import all existing sets of data.

b) Export:
Highlight the option Open database in the Files menu and select 
the sets of data that you wish to export. 
The fi les will be stored in the fi le path predefi ned under Settings 
in the Options menu. You can change this path as needed. 

Deleting data
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6. 1 Fault location
Fault Proposal for a solution
In the remote control win-
dow there are no client or 
test data on display.

1.  The connection with the AD-
Scan unit may be disconnected. 
Check the control window on 
the left hand side on a corre-
sponding note (this window do-
cuments all actions around the 
ADScanalyzer software). „The 
scanner is switched off or the 
USB-connection is interrupted“ 
should be visible. If this is the 
case, reconnect the ADScan 
device to the computer using the 
USB isolator.

2.  The checkmark for „Only show 
new test results“  (see below) is 
active. Remove the checkmark 
in the box by clicking on it.

3.  No new tests were stored on 
this unit since  existing data was 
last removed.  

The ADScan cannot be 
operated using the integra-
ted buttons on the device 
and the display reads „Re-
mote control“.

Once connected to the computer 
the integrated menu structure of the 
ADScan unit is deactivated.  

Decide if you wish to 

• remote control the ADScan via 
your computer– then use the AD-
Scanalyzer interface accordingly 
(see chapter 4 for reference) 

• use the buttons on the ADScan 
unit to control the system – if 
so, remove the USB connection 
between your computer and the 
ADScan device to regain access 
to the unit’s keyboard. 

Fault location

6. Maintenance and technique
In this Chapter you learn what to do to overcome obstacles when 
using the ADScan unit. 

Der Scanner ist 
ausgeschaltet 
oder die USB-
Verbindung ist 
unterbrochen.



37

6. Maintenance and technique

Did any other questions, faults or problems occur when working 
with the ADScan unit?
Please, contact our technical customer support:  
+49-(0) 5130-97778-55
We will discuss further measures together!

Fault location

Starting the device or 
initializing the connection 
with the ADScanalyzer 
software takes too long.

1.  Turn the device off and then back 
on. Try to restart the test. 

2.  Too many tests are stored on 
the device. The corresponding 
processing time is too extensive. 
Delete a larger number of tests 
from the ADScan unit prior to 
starting another recording. 

A test does not start / 
upon the start there are 
fi ve instead of four bee-
ping sounds audible.

1. Turn the device off and then back 
on. Try to restart the test. 

2.  The internal memory of the AD-
Scan unit might be full. Check 
the remaining free data memory. 
Delete a larger number of tests 
from the ADScan unit in order to 
free up data storage capacity. 

The ADScan ist turned on 
but is not being recognized 
by the software.

1. Check the connection between 
computer and USB isolator re-
spectively between USB isolator 
and ADScan unit. Are the USB 
cables connected properly on 
each end? If NOT: Re-insert cable 
to establish the connection.

2. Turn unit off; wait 10 seconds; 
now turn unit back on; If there is 
no improvement: 

3. Turn unit off again; close the AD-
Scanalyzer software; wait for 10 
seconds; turn device back on and 
start the software. If still there is 
no functionality:

4.  Turn off unit and close the soft-
ware. Reboot your computer. 
Turn unit back on and restart the 
software.
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Maintenance

6.2   Maintenance and Calibration
Maintenance of the ADScan unit may only be done by technical 
service personal or correspondingly trained staff. 

Manufacturer requirements: An annual calibration is mandatory 
to ensure reliability of all recordings and their respective evaluation. 
The manufacture recommends to sign a maintenance- and  service 
contract for the ADScan system. 

6.3  Cleaning
After usage clean the ADScan unit and the push button using a 
commercially available desinfection cloth.

Attention: By all means take not of the safety and usage in-
structions provided by the cloth’s manufacturer. Failure to do 
so may cause health issues or damage the device. 
Attention: Protect the device from ultrasound baths, running 
water and chemical detergents such as diluting agents and 
alcohol. The device may be damaged.

6.4 Storage
To store the ADScan unit turn it off using the power switch and 
disconnect the power adapter and the USB cable.   
• Only store the device in a dry closed room at room temperature. 
• For long term storage or transportation use the hard-top case 

provided to you with the ADScan system.

6.5 Disposal
The ADScan unit and its components are part of the power-adapter 
driven small electronic devices.
• You can return the ADScan, the power adapter and the 

USB-Isolator to your local collection station (if so applicable 
in your respective country). Device category: Small electrical 
appliance.

•  The hard-top case and the remaining accessories may also 
be turned over to the local collection station.

If you do not want to simply dispose of your ADScan system, we 
will be happy to take it back. We will utilize it in a sensible and  
environmentally sound way. 
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Technical data

6.6    Technical data 
ADScan
Power supply 12 V (über mitgeliefertes Netzteil)
Power consumption ca. 400 mA
Weight 440 g
Size in cm
(Height x width x depth)

16 x 20 x 7

Radar module
Power supply 5 V
Power consumption 40 mA (typ.)
Transmission frequency D, A, PL: 9.35 GHz

JP: 10.525 GHz
FR: 9.9 GHz

Effectrive radiated power 10 dBm EIRP
Stimulus diode
Form LED-Dot-Matrix 5 x 7
Colour rot
Wavelength 640 nm (dom.)
Power consumption max. 5 V
Luminous intensity 36.000 lv (typ.)
Conditions for operation
Ambient temperature 15 ° C to 30 ° C (20 ° C ideal)
Relative air humidity 45 % to 70 %

Computer Requirements  
 (minimum)
CPU 1,8 GHz Dual Core Prozessor – or higher
RAM 1 GB at Windows XP / 

2 GB at Windows Vista respectively 7
Hard disk 1 GB
Operating system Windows® XP / Vista / 7
Screen 1024 x 768 dots
Graphic card S-VGA (compatibel)
Others USB-Port, CD/DVD-drive

mouse, keyboard



40

6. Maintenance and technique

6.7 Type plate

 Type

Manufacturer

Serial number

Article number

On the back of the ADScan there is the following type plate. The 
entries and symbols on it have the following meaning.

This icon means that the usage of the ADScan requires 
additional ‚applied parts‘ which are not included in the scope 
of supply. This means a computer and the push button. 

Attention, read and understand 
the instructions before use!

Applied part

Year of manufacturing

Environment  
disposal classifi cation

Type Plate

Technical specifi cation for input and 
output voltage

Insert the appropriate adapter for your mains 
before you use the AC adapter.

Suitable for use with medical devices

Environment disposal classifi cation

Manufacturer‘s specifi cations

Protection class codes (class 2)

Warning - use only in dry rooms allow, since it might cause 
electric shock. 

Adapter – despends on the country

Cable to ADScan
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6.8 Electromagnetic compatibility –  
 Guidance and manufacturer‘s declaration

Electromagnetic compatibility
DIN EN 60601-1-2:2011 (IEC 60601-1-2:2011)
Medical electrical devices are subject to special precautionary measures in particular 
regarding the EMC with the installation and the operation.
Portable and mobile HF-communication devices e.g. mobile phonecan affect medical 
electrical devices.
A use of other accessories and lines than the indicated, can lead to an increased 
sending or a reduced noise immunity of the equipment. The equipment has to be 
operated exclusively with original accessories.
The device should not be used adjacent to or stacked with other equipment. If ad-
jacent or stacked use is necessary, the device should be observed to verify normal 
operation in the confi guration in which it will be used. 

Electromagnetic emissions
ADScan is intended for use in the electromagnetic environment specifi ed below. The 
customer or the user of the ADScan should assure that it is uded in such environ-
ment.
Emission test Compliance Electromagnetic environment - guidance
RF emissions 
CISPR 11

Group 1 The ADScan uses RF energy only for 
its internal function. Therefore, its RF 
emissions are very low and are not likely 
to cause any interference in nearby elect-
ronic equipment.

RF emissions 
CISPR 11

Class B The ADScan is suitable for use in all 
establishments, inluding domestic esta-
blishments and those directly connected 
to the public low-voltage power supply 
network that supplies buildings udes for 
domestic purposes.

Harmonic emissions 
IEC 61000-3-2

not applicable

Voltage fl uctuations / 
fl icker emissions IEC 
61000-3-3

passed
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Electromagnetic immunity I
The ADScan is intended for use in the electromagnetic environment specifi ed below. The 
customer or the user of the ADScan should assure that it is used in such environment.
Immunity test IEC 60601 test 

level
Compliance level Electromagnetic environment - 

guidance
Electrostatic di-
scharge (ESD) 
IEC 61000-4-2

 6 kV contact
 8 kV air

 6 kV contact
 8 kV air

Floors should be wood, con-
crete or ceramic tile. If fl oors are 
covered with synthetic material, 
the relative humidity shall be al 
least 30 %.

Electrical fast 
transient / burst 
IEC 61000-4-4

 2 kV for power 
supply lines

 1 kV for input / 
output lines

 2 kV for power 
supply lines

 1 kV for input / 
output lines

Mains power quality should be 
similar to that of a typical com-
mercial or hospital environment. 

Surge IEC 
61000-4-5

 1 kV common 
mode

 2 kV differential 
mode

 1 kV common 
mode

 2 kV differential 
mode

Mains power quality should be 
similar to that of a typical com-
mercial or hospital environment. 

Voltage dips, 
short interrup-
tions and volta-
ge variations on 
power supply 
input lines IEC 
61000-4-11

< 5 % UT
(> 95% dip of  UT) 
for 1/2 cycle
40 %  UT
(60 % dip of UT)
for 5 cycle
70 %  UT
(30 % dip of UT)
for 25 cycle
<5 %  UT
(> 95 % dip of  UT)
for 5 s

% UT
(> 95% dip of  UT) 
for 1/2 cycle
40 %  UT
(60 % dip of UT)
for 5 cycle
70 %  UT
(30 % dip of UT)
for 25 cycle
<5 %  UT
(> 95 % dip of  UT)
for 5 s

Mains power quality should be 
similar to that of a typical com-
mercial or hospital environment. 
When the user of the ADScan 
continued function also calls 
in the envent of disruption of 
supply, it is recommended the 
ADScan form an uninterruptible 
power supply.

Power frequen-
cy (50/60 Hz) 
magnetic fi eld 
IEC 61000-4-8

3 A/m 3 A/m Power frequency magnetic 
fi elds should be at leves charac-
teristic of a typical location in 
a typical emmercial or hospital 
environment.

Note: UT is the ac mains voltage prior to application of the test level. 



43

6. Maintenance and technique

Electromagnetic immunity II
The ADScan is intended for use in the electromagnetic environment specifi ed below. 
The customer or the user of the ADScan should assure that it is used in such environment.
Immunity test IEC 60601 

test level
Compliance 
level

Electromagnetic environment - guidance

Conducted RF 
IEC 61000-4-6

3 V eff
150 kHz to 
80 MHz

3 V eff
150 kHz to 
80 MHz

Portable and mobile RF communication 
equipment should be used no closer to any 
part of the ADScan, including cables, than 
the recommended sparation distance cal-
culated from the equation applicable to the 
frequency of the transmitter.

Radiated RF 
IEC 61000-4-3

3 V/m
80 MHz to 
2,5 GHz

3 V/m
80 MHz to 
2,5 GHz

Recommended separation distance: 
d = 3,5/3 P
d = 3,5/3 P 80 MHz to 800 MHz
d = 7/3 P 800 MHz to 2,5 GHz
Where P is the maximum output power rating 
of the transmitter in watts (W) according to 
the recommended separation distance in 
meters (m). 
Field strength form fi xed RF transmitters, 
as determined by an electromagnetic site 
surway A, should be less than the compliance 
level in each frequency range B.
Interference may occur in the vicinity of 
equipment marked withthe following symbol: 

Note 1: At 80 MHz and 800 MHz the higher frequency range applies.
Note 2: These guidances may not apply in all situations. Electromagnetic propagation is affected by 

absorption an refl ection from structures, objects and people.
A Field strenghts from fi ced transmitters, such as base stations for radio (cellular / cordless) tele-

phones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast 
cannot be predicted theoretically with accuracy. 

 To access the electromagnetic environment due to fi xed RF transmitters, an electromagnetic 
site survey should be considered. If the measued fi eld strength in the location in which the 
ADScan is used exceeds the applicable RF compliance level above, the ADScan should be 
observed to verify normal operation. 

 If abnormal performance is observed, additional measures may be necessary, such as reori-
enting or relocating the ADScan. 

B Over the frequency range 150 kHz to 80 MHz, fi eld strengths should be less than 10 V/m.
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6. Maintenance and technique

Recommended separation distances for portable and mobile 
RF communication equipment and the ADScan
The ADScan is intendes for the use in the electromagnetic environment in which ra-
diated RF disturbances are controlled. The customer or user of the ADScan can help 
to prevent electromagnetic interference by maintaining a minimum distance between 
porable and mobile RF communication equipment (transmitters) and the ADScan as 
recommended below, according to the maximum output power of the communica-
tions equipment.
Rate maximum 
output power of 
tranmitter
W

Separation distance according to frequency of transmitter 
m

150 kHz to 80 MHz
d = 3,5/3 P

80 MHz to 800 MHz
d = 3,5/3 P

800 MHz to 2,5 GHz
d = 7/3 P

0,01 0,12 0,12 0,23
0,1 0,37 0,37 0,74
1 1,17 1,17 2,33
10 3,69 3,69 7,38
100 11,67 11,67 23,33

For transmitters rated at a maximum output power not listed above, the recommended 
separation distance d in meters (m) can be determined using the equation applicalbe 
to the frequency of the transmitter, where P is the maximum output power ratin of the 
transmitter is watts (W) according to the transmitter manufacturer.

Note 1: At 80 MHz and 800 MHz the higher frequency range allies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propa-

gation is affected by absorption and refl ection from structures, objects and 
peoples.  
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7. Service

7   Service

7.1 Manufacturer and contact 
MediTECH Electronic GmbH
Langer Acker 7
D-30900 Wedemark
Tel.:  +49-(0)5130-97778-0
Fax:  +49-(0)5130-97778-22
Mail: service@meditech.de
Internet:  www.meditech.de

7.2 Warranty

After acquiring the ADScan unit from MediTECH Electronic 
GmbH you are granted a warranty claim for faultless opera-
tion of the device that will expire after two years. Malfunction 
and damage from improper use are excluded.

Beside this warranty, we are supplying a hotline service for 
any questions and problems for all the time you will be wor-
king with the system.

You may call the hotline at the phone number:

+49-(0) 5130 - 97778-0
Of course you may also send your questions in written form: 

by fax:  +49-(0)5130 - 97778-22
by email:  service@meditech.de

7.3 EC declaration of conformity

Please, fi nd the current EC declaration of conformity of this 
product at www.ce.meditech.de.

Contact



http://www.adscan.meditech.de

GBA-ADScan-GB-V01.1-15.02.2013
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